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Eudora Reference Guide

1. Creating an Outgoing Message

An outgoing message is a message you send to someone else.  

To create an outgoing message, select “New Message” from the Message 
menu.  The window of a new message entitled <<No Recipient>> <<No 
Subject>> will appear.  The insertion point will be blinking at the start of 
the “To:” field of the message header.  

The Icon Bar
The icon bar consists of a series of objects that are displayed just under the 
title of the window.  It allows you to control your message’s priority, 
override some of your preference settings for that message only, and send 
or queue the message.  There is one priority popup and five icons, each 
which may or may not have a check mark next to it.  The preferences, 
indicated by the icons, may be turned on or off for the current message by 
clicking on the corresponding icon.  A check mark symbol appearing next 
to the icon denotes that the option has been turned on.  The priority popup 
menu and the icons are described below.

Figure 1.1.  The Icon Bar
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Priority popup.  The leftmost object in the icon bar is the priority popup 
menu. For most messages, this is just an empty box, which means the 
message will be sent at a normal priority.  If you want to indicate that your 
message is of higher or lower priority than a normal message, use this 
menu.  Priorities are discussed in Section 19 of this manual.

Signature (John Hancock).  If this icon is checked, Eudora will 
automatically attach your signature file to the end of each message you 
send (see Section 23).

Word-Wrap.  If this icon is checked, a carriage return is not required at 
the end of each line you type in; Eudora will 
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automatically “wrap around” to the next line.  Your message will be 
formatted with line breaks at about 76 characters per line.

Tabs in Body.  If this icon is checked, hitting the TAB key when in the 
message body will result in Eudora inserting enough spaces to move the 
insertion point to a multiple of 8 characters from the start of the line.  This 
mimics the way tabs work on many terminals. Otherwise, hitting the TAB 
key will advance the cursor to the “To:” field of the message header.

Note: This icon also controls the handling of tabs in text that is 
pasted into the message window and in plain text 
attachments that are not binhexed.  If Tabs in Body is 
checked, tabs will be replaced with spaces; otherwise, the 
tabs will be sent as-is.

Keep Copy:  If checked, a copy of each sent message will be kept in the 
Out mailbox (their summaries will be marked with an “S” in the far left 
column of the Out mailbox window, indicating that they have been sent).  
These message are saved until they are deleted or transferred to a different 
folder.

BinHex ‘TEXT’:  If checked, plain text files sent as attachments will be 
encoded in BinHex format; otherwise, they will be appended to the 
message with no encoding, as though you had typed them into the body of 
the message.

Send or Queue: If you have the “Immediate Send” option checked in the 
“Switches...” dialog box under the Special menu, the rightmost button in 
the icon bar will be labeled “Send,”  and clicking on this button will 
immediately send the message.  Otherwise, this button will be labeled 
“Queue,” and will function like “Queue for Delivery” under the Message 
menu (i.e., upon clicking this button, the message window will close and 
the message will be held in the Out mailbox, marked ready for delivery; 
further details on sending messages may be found in Section 3).

The icon bar itself is optional, and to eliminate it from composition 
windows, de-select “icon bar” in the “Switches...” dialog (Section 25).  
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The Message Header and its Fields
An e-mail message is divided into two major parts, the header and the 
body (see Figure 1.2).  The header is the top portion of a message and 
consists of a group of fields (spaces for holding information).  In Eudora, 
there are six fields displayed in an outgoing message header:  To:, From:, 
Subject:, Cc:, Bcc: and Attachments:.  Each field holds a different piece of 
information.  The To:, Subject:, Cc:, and Bcc: fields may be directly 
edited.
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Header

Body

Figure 1.2.  A composition window; header and body.

To move the insertion point from field to field, press the TAB key or click 
in the desired field with the mouse.  When entering information into the 
fields, use the standard Macintosh text-editing tools provided under the 
Edit menu.  Here is a brief description of the intended contents of each 
field:

To:  The intended recipient’s e-mail address, or a nickname you have 
defined (see Section 13).  Multiple addresses are allowed, but must be 
separated by commas.

From:  The sender’s e-mail address.  This will usually be your POP 
account plus your real name.  You can use an address other than your POP 
account by using the Return Address box in the “Configuration...” dialog 
(see Section 24).  You may not change this field in a message; you must 
use the “Configuration...” dialog.

Subject:  Brief text indicating the contents of the message.  This field 
may be left blank (though it is a breach of e-mail etiquette to do so).

Cc:   E-mail address or nickname of person to whom a copy of the 
message is to be sent.  Multiple addresses are allowed but must be 
separated by commas.  This field may be left blank.

Bcc:  “Blind” carbon copy.  Like addresses listed in the Cc field, address 
listed here will receive copies of the message.  Unlike addresses listed in 
the Cc: field, addresses listed in the Bcc: field will not appear in the 
message header of the recipients.  This is useful when you want to send a 
copy of a message to someone without everyone else knowing you did so. 
Multiple addresses are allowed but must be separated by commas.  This 
field may be left blank.

Attachments:  List of documents being sent along with the message.  
Specify these through the “Attach Document” command under the 
Message menu (see Section 11).  Delete them by clicking on one and 
pressing “delete”.  You may not enter information directly into this field.  
This field may be left blank.
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The Body of the Message
After filling in the fields, move the insertion point to the space below the 
message header.  Here you may type the text of the body of the message.  

Feel free to use the standard Macintosh text-editing tools provided under 
the Edit menu (see Section 30).

If the “Word-wrap outgoing mail” option in the “Switches...” dialog (see 
Section 25) or icon bar is checked, you don’t need to press <return> at the 
end of a line of text. The text will wrap around to the next line 
automatically.  If this option is not set, be sure to type in a <return> at the 
end of each line or your message may not be legible on the recipient’s 
computer.

2. Saving an Outgoing Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a 
safeguard when typing long messages, or so you can return to it later to 
edit or add more text.  

To do this, while the outgoing message window is open, select “Save” 
from the “File” menu.  The message will not be closed but the current 
version of the message will be saved in the Out mailbox.  You might 
notice that the title appearing at the top of the message window will 
change from <<No Recipient>> << No Subject>> to what you typed in 
the “To:” and “Subject:” fields of the message.

If you were to then close the message (by clicking the close box in the 
upper left-hand corner of the message window, or by choosing “Close” 
from the File menu), it could be re-opened from the Out box for further 
changes.  As with any message summary listed in a mailbox window, it 
can be identified there by the contents of its “To:” and “Subject:” field. A 
small black dot, or bullet, to the left of a message summary listed in the 
Out mailbox (see Figure 2.1) indicates that the message is being 
indefinitely held there and is “queueable.”  Such messages will remain in 
the Out mailbox until they are queued and sent or deleted.
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Figure 2.1. A sendable message saved in the Out mailbox.

If you try to close an outgoing message window without specifically 
saving that version of the message, a dialog box will appear asking you if 
the message should be saved or the changes 
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discarded. If you choose to discard changes and the message has never 
been saved, the message will be deleted. 

Figure 2.2. Closing an unsaved composition window.

3.  Sending A Message

One-Step Send
If you check “Immediate Send” in the “Switches...” dialog box (see 
Section 25), Eudora will send the current outgoing message as soon as you 
select “Queue for Delivery” from the Message menu.  

Alternatively, if you have both “Immediate Send” and “Icon Bar” selected 
in the “Switches...” dialog box, the rightmost button appearing in the icon 
bar at the top of the open message window will be labeled “Send.”  
Clicking on this button will immediately transmit the message.

Figure 3.1. Clicking the Send button.

If “Show Progress” is selected in the “Switches...” dialog box, progress 
windows will momentarily appear at the top of the screen when you 
actually send the message, indicating the transmission process as it occurs. 

Figure 3.2.  Progress Window
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Two-Step Send
Some people may prefer to compose many messages, and transmit them 
all at once.  This is only possible if you do not select “Immediate Send” in 
the “Switches...” dialog box (see Section 25). 

To accomplish the first step for any current outgoing message,  select 
“Queue For Delivery” from the Message menu.   Alternatively, if your are 
using the icon bar option, you may click on the rightmost button appearing 
in the icon bar at the top of the message window, which will be labeled 
“Queue.” 

Figure 3.3. Clicking the Queue button.

Either of these selections will close the message window (if it was open), 
save the message in the Out mailbox and mark it as “queued,” meaning 
ready to be delivered.  Opening the Out mailbox will reveal that queued 
messages are marked by a “Q” in the far left-hand column (see Figure 
3.4).
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Figure 3.4. A Queued message in the Out mailbox.

For the second step, under the File menu select “Send Queued Messages”. 
This will send out the queued message.  If “Show Progress” is selected in 
the “Switches...” dialog box, the Progress window will momentarily 
appear when you actually send the message.

Timed Messages
It is possible to tell Eudora to send a message at some specific time in the 
future.  To do this for the current outgoing message, choose “Change 
Queueing...” from the Message menu.  You will be presented with the 
following dialog box:
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Figure 3.5. Change Queueing dialog.

If you choose “Right Now”, you get the same result as a One-Step Send.  
If you choose “Next time queued messages are sent”, it is the same as 
Two-Step Send.  If you choose “On or After”, you may use the time and 
date boxes below to fill in the time when the message should be sent.  The 
message will be saved in the Out mailbox with a “Q” in the status column, 
as for a Two-Step Send.  However, the message will not actually be sent 
until the specified time arrives.

Note: For the message to be sent on time, Eudora must be 
running when the message is due to be sent.  If Eudora is 
not running, the message will be sent the first time Eudora 
is run after the time has passed.

Sending Queued Messages on Check
If you select “Send on Check” in the “Switches...” dialog box, every time 
a manual or automatic mail check occurs, any queued messages will be 
sent out, thus saving you the step of choosing “Send Queued Messages”.  

Quitting with Queued Messages
If you quit Eudora after you have queued some messages, but without 
sending them with “Send Queued Messages,” you will be given the 
opportunity to send the messages before Eudora quits.
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Figure 3.6. Quitting with queued messages.
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If you quit with timed messages, Eudora will warn you if the messages are 
due to be sent within the next 12 hours, and give you the opportunity to 
send them.

Figure 3.7. Quitting with timed messages.

Note: If you have both queued messages and timed messages that  
are due to be sent in the next 12 hours, you will be the 
lucky recipient of both warnings.

Editing a queued message
A message that is queued but as yet unsent may be un-queued with the 
“Change Queuing...” command found under the Message menu.  This is 
the only way to change the message status from “queued” to “queueable” 
(i.e. “saved”).  The message will be held in the Out mailbox until it is 
either deleted or re-queued and sent.  

Note: You may also send a message immediately or change it to 
timed send with the “Change Queuing...” command.

If you choose to open a queued message for further editing, you may re-
queue the new version of the message with the “Queue For Delivery” or 
“Change Queuing...” commands from the Message menu or the “Save” 
command from the File menu.  The message will return to the Out 
mailbox with a queued status.  If you close the changed message without 
choosing one of these, a dialog box will appear verifying that the 
additional changes should be included.  
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Keeping Copies of Outgoing Messages
Once a message is sent, it is put into the Trash mailbox, unless “Keep 
Copies” is selected in the “Switches...” dialog box or in the icon bar.  In 
that case,  the message is left in the Out mailbox, and is annotated with an 
“S” in the status column of the Out mailbox (see Figure 3.8).
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Figure 3.8. Copy of outgoing message saved in Out mailbox.

4.  Password Protection

There is password protection on mail checks to the POP server.  Each time 
the Eudora program is opened, your password will be requested prior to 
the first mail check, whether it is conducted automatically or manually 
(see Section 5).  If automatic checking is set, upon first opening Eudora, a 
dialog box requesting your POP server account password will appear.  If 
automatic checking is disabled, upon the first manual check, the same 
dialog box will appear, requesting your password. 

Figure 4.1. Password dialog.

In either case, type in your password in the box at the insertion point and 
click the “OK” button.  If you make a mistake before clicking “OK,” 
simply backspace and re-enter the password correctly.  

If your password is rejected, you will have to do a manual check for mail 
(i.e., choose “Check Mail” from the File menu) to have another chance to 
enter your password.
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Figure 4.2. Oops.  Wrong password.

As long as it is running, Eudora remembers your password.  If you don’t 
want it to remember (when, for example, you will be away from your 
Macintosh), choose “Forget Password” from the Special menu.  Your next 
mail check will prompt you for your password again.  

Another password-related option is “Save Password” which is in the 
“Switches...” dialog box.  This option makes Eudora remember your 
password from one session to the next (i.e. you NEVER have to enter your 
password again, even if you quit and restart Eudora).  This option should 
only be used if your machine is in a secure location.

Finally, the “Change Password...” command in the Special menu can be 
used to change your POP server password, if your POP server machine is 
running a compatible password-change server.  You’ll be asked to enter 
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your old password once, and your new password twice.

Figure 4.3. Changing a password with Eudora.

Note: For information on password-change servers, see 
Appendix A of this manual.
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5.  Checking For and Receiving Mail

The POP (Post Office Protocol) server is the machine where your mail is 
received and stored until it is transferred to the Eudora program on your 
Macintosh system.  Your POP server account is specified in the “POP 
Account” setting in the “Configuration...” dialog (see Section 24).

Note: To best understand the functioning of the POP server with 
respect to Eudora, please see Appendix C.

There are two ways to check your designated POP server to see if new 
mail has arrived and have it forwarded to Eudora.  One way is automatic 
and the other is manual.  Before any checks are made, however, your POP 
account password will be requested (see Section 4).

Automatic Checking
Eudora provides for an automatic mail check whose frequency is 
determined by the “Check for mail every ? minute(s)” setting in the 
“Configuration...” dialog (see Section 24).   Leaving this setting empty 
disables the automatic check.  Any other number entered here denotes the 
number of minutes between automatic checks to the POP server.  An entry 
of “10” (for 10 minutes) is recommended as a good minimum time; 
checking mail more frequently may result in unnecessary load on your 
POP server. 

An automatic check provides for polling of the POP server so that you can 
receive new mail without having to choose “Check Mail” from the File 
menu.  Automatic checking works whenever Eudora is running, even if 
you are using other Macintosh applications.  You can be notified of new 
mail in one or all of four different ways; an alert, a special sound, a 
flashing mail flag icon in the menu bar, or the opening of the In mailbox.

Figure 5.1. New mail icon in the menu bar.

To view the new mail message(s), switch to the Eudora program.  
Depending on the settings you have chosen in the “Switches...” dialog, the 
In mailbox may already be open for you.  Otherwise, you will have to 
choose “In” from the “Mailbox” menu to see your new mail. Mail always 
arrives in the In mailbox.  Unread messages in the In box are designated 
by a small black dot, or bullet, on the left side of the message summary 
(see Figure 5.2).  Double-clicking on a message will open it.  Incoming 
messages are saved indefinitely in the In mailbox unless they are deleted 
or transferred to another mailbox.
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Figure 5.2. Mail arriving in the In mailbox.

Note: If you choose to have the In mailbox opened for you when 
mail arrives, the selection in that mailbox will be changed 
to FUMLUB. FUMLUB is an acronym for “the First 
Unread Message of the Last Unread Batch”. That is, 
Eudora selects the first unread message following the last 
read message.  The mailbox will, however, be scrolled to 
the bottom, even if this means the selected message isn’t 
visible.

If automatic checking is set, the “Check Mail” command under the File 
menu will show the next time that an automatic check is scheduled to 
occur.  

Manual Checking
You may check for mail manually at any time by selecting “Check Mail” 
from the File menu.  If you haven’t successfully entered your password 
since opening the Eudora program, you will be prompted for it. 

If the “Show Progress” option is selected in the “Switches...” dialog, the 
Progress window will appear temporarily at the top of the screen as the 
POP server is checked.

Figure 5.3. The Progress window during a mail check.

If there is no mail waiting at your account on the POP server, nothing 
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more will happen.  You may check for mail again later.  If there is a 
problem reaching the POP server, a dialog box with an error message will 
appear, such as the one in Figure 5.4.  To rectify the problem, review your 
POP server settings in the “Configuration...” dialog for correctness.  If 
there is no obvious error, contact your system administrator.
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Figure 5.4. Error while checking mail.

If there is new mail, any messages will be transferred automatically from 
the POP server to Eudora on your Macintosh system.  If you have checked 
the “Show Progress” option in the “Switches...” dialog box, the transfer of 
messages will be reflected in the progress window at the top of the screen. 

Following this (depending on the settings you’ve chosen in the 
“Switches...” dialog), the new mail dialog may appear, stating that mail 
has arrived.

Depending on your settings, the In mailbox window may appear.  Mail 
will always arrive in the In mailbox.  Unread messages in the In box are 
designated by a small black dot, or bullet, on the left side of the message 
summary (see Figure 5.2).  Double-clicking anywhere on a selected 
message summary will open the message on the screen.  Incoming 
messages will be saved indefinitely in the In mailbox unless they are 
transferred to another mailbox or deleted.

“Leave Mail on Server” Option
Eudora normally transfers your incoming messages from your account on 
the POP server to your Macintosh, and deletes them from the POP server.  
This may prove awkward for people who sometimes want to read mail 
from a secondary Macintosh system.  It results in non-consolidated storage 
of messages; if you read mail through a secondary Macintosh, you 
wouldn’t be able to act on that mail from your primary Macintosh.

The “Leave Mail on Server” option in the “Switches...” dialog solves this 
dilemma.  If this option is checked, Eudora will transfer all of your new 
messages from the POP server to the Macintosh you are presently using 
(presumably a secondary Macintosh), while keeping copies of those 
messages in your account of the POP server. On the next mail check, 
Eudora will ignore the copies of previously read messages, and look for 
new ones.  
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If you have checked “Leave mail on server” in the “Switches...” dialog, 
you will see the following message on your screen, before Eudora 
transfers any new mail upon a manual check:

Figure 5.5. Progress window when “LMOS” is on.

When using your primary Macintosh system, you should uncheck the 
“Leave Mail on Server” option, so that all messages (new ones as well as 
copies of old ones you read through other Mac systems) will be transferred 
to and consolidated on the one primary system.  The “Leave Mail on 
Server” option should be used with care, since it can result in a buildup of 
messages on the POP server machine.

Note: Eudora looks for a “Status: R” header to determine if a 
message has been read.  Your POP server will have to 
cooperate for this to work; most do.

The “Skip Big Messages” Option
If you select the “Skip Big Messages” option from the “Switches...” 
dialog, Eudora will not download large messages.  Instead, it will 
download only the first few lines of such messages, and add a note at the 
bottom stating that the whole message has not been transferred.  This can 
be useful on slow connections.

Figure 5.6.  The rest of this message was skipped.
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Turn “Skip Big Messages” off if you want to get all of the big message.

Note: Eudora considers “big” to mean 40K.  Eudora requires 
some help from your POP server to make “Skip Big 
Messages” work properly.  Specifically, Eudora expects 
your server to add a “Status:” header once Eudora has 
downloaded the first few lines of the message.  Eudora uses  
that line as a signal that it already has the first few lines 
and doesn’t need to download them again.  

Stopping a Mail Check
If you want to stop a mail check in the middle, just hold down the 
command (Apple) key and press period.

6.  Anatomy of a Mailbox Window

Mailbox windows are one of the most important elements of Eudora.  One 
is pictured in Figure 6.1.

Figure 6.1. A mailbox window.

Message Summaries
Each line in a mailbox window represents one message, and is called a 
message summary.  To select a message summary, just click on it.  
There are several ways to select more than one summary. You can press on 
a summary and drag through the ones you want to select. You can click on 
one summary, hold down the shift key and click on another summary; this 
will select both summaries and all the summaries between them. Finally, 
you can hold down the command (Apple) key, and click on the messages 
you want to select; this allows you to make “disjoint” selections.

Figure 6.2. A disjoint selection in a mailbox window.

Mailbox Window Columns
A mailbox window (and hence each message summary) is divided into 
five columns:  status/priority, sender/recipient, date, size, and subject.

The status & priority column displays two separate items.  The first is 
the message status, which may be one of the following:
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• The message has not been read (all mailboxes except Out), or 
is queueable but has not been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is 
not yet able to be queued because it has no recipients (Out 
mailbox only).

R “Reply” has been chosen for the message.
F “Forward” has been chosen for the message.
D “Redirect” has been chosen for the message.
S The message has been sent (outgoing messages only).
- The message was transferred from the Out mailbox before 

being sent.
The message priority is displayed by one of the following small icons:

Highest priority

High priority
Normal (blank)
Low priority
Lowest priority

For more information on message priorities, see Section 19 of this manual.

The sender/recipient column shows the sender of the message (for 
incoming messages) or the recipient or intended recipient (for outgoing 
messages).

Note: Bugs in some POP servers/mail transport systems may 
result in Eudora displaying the sender of incoming 
messages as ???@???.  This is because the required 
“From:” header is missing.

The date column displays the date and time the message was sent, or for 
timed messages, the date and time the message is scheduled to be sent.

Note: The date is formatted according to the short date format 
in current use by your Macintosh, and the time is formatted  
according to the current time format.

The size column displays the size of the message, in K (a “K” is 1024 
bytes), and the subject column displays the subject of the message.

Resizing Columns
You can resize any column in mailbox windows.  Move the mouse until it 
is over the dotted column divider to the right of the column you want to 
resize.  The cursor will turn into the column resize cursor.
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Figure 6.3. Column resize cursor.

Simply press the mouse button, drag the divider to the position you desire, 
and release the mouse button.  The column divider will move to the new 
location, and the mailbox will be redrawn.

Figure 6.4. Mailbox after resizing column.

You can only drag a column divider as far as the divider to its left.  If you 
do so, you will see a double divider line in place of the column, and the 
contents of the column will not be displayed.  To make the column show 
again, just drag the right half of the double line to the right.

Figure 6.5. Mailbox window with a hidden column.

The Size Display
The lower-left corner of each mailbox window displays size information 
for that mailbox.  Three numbers are displayed.  The first is the number of 
messages in the mailbox.  The second is the total amount of space those 
messages require.  The third number is the amount of space that is wasted 
in the mailbox.  Eudora will occasionally recover this wasted space; you 
can force Eudora to recover it earlier by choosing “Compact Mailboxes” 
from the Special menu.
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Figure 6.6. This mailbox has 22 messages in it, which take 42K of disk space.  
No disk space is wasted in this mailbox.

7. Opening a Mailbox to Read a Message

Under the Mailbox menu, select the desired mailbox from the list of 
mailboxes.  A mailbox window will be displayed.  If any messages are 
stored in this mailbox, they will be listed as individual message summaries 
appearing in this window.  A message summary usually includes the 
message status and priority, the sender/recipient of the message, the 
subject heading, the date it was received and its size.  Double-click on any 
message summary listed in the mailbox window to open the message on  
screen. (You can also use the “Open...” command from the “File” menu, or 
press the “enter” key.)

Figure 7.1. Double-click a message summary to open the message.

If you wanted to open a “nested” mailbox, that is, one that has been 
contained within a mail folder, you would first select its outermost folder 
from the Mailbox menu (folders are designated by an arrow next to their 
names).  This will yield a sub-menu of mailboxes and/or other folders 
within it, from which you may select the desired mailbox (see Figure 6.3). 
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Figure 7.2. Opening a mailbox in a mail folder.

8. Deleting a Message

As a safeguard against inadvertent deletions, two steps are required to 
delete a message in Eudora.  For any current message, choose “Delete” 
from the Message menu.  This will not actually destroy the message, but 
transfer it to the Trash mailbox.  To delete messages from the Trash 
mailbox, select “Empty Trash” from the Special menu.  Quitting the 
program can also delete contents of the Trash mailbox, if you select 
“Empty Trash on Quit” in the “Switches...” dialog.  Finally, if you want to 
delete just a few messages from the Trash, select them and choose 
“Delete” from the Message menu; deleting a message that’s already in the 
Trash removes it from Eudora completely.

Also, unless you have set “Easy Delete” in the “Switches...” dialog box, 
any attempt to delete a message that you have never opened (or a Queued 
message you haven’t sent) will result in Eudora asking for confirmation 
before proceeding with the deletion.
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Figure 8.1. Warning for deleting unread or unsent messages.

Compacting Mailboxes: Recovering Storage Space 
Even after a message has been deleted with the two-step process described 
above, the storage space which that message originally required is still 
taken.  Normally, Eudora will recover this space automatically when it 
becomes troublesome.  However, if disk space is very tight, you can force 
this to happen earlier than usual.  In order to reclaim the storage space, 
select the “Compact Mailboxes” command from the Special menu.

Note: Eudora compacts mailboxes automatically when you close 
them, under either of two conditions.  Mailboxes are 
compacted if the amount of wasted space in the mailbox is 
greater than the amount of space the messages in the 
mailbox use, or if the amount of space wasted in the 
mailbox is greater than 5% of the free space on the volume 
that contains it.
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9.  Transferring a Message to a Different Mailbox

Messages may be transferred between any two mailboxes, with the 
exception that no messages may be transferred to the Out mailbox. 

For any current message, select from the Transfer menu the mailbox to 
which the message should be transferred.  The message will be removed 
from its previous location and stored in the specified mailbox.

Figure 9.1. Transferring a message.

If you hold down the option key when you transfer a message, the 
message will be copied into the new mailbox, not transferred.  This is 
useful if you want to file a message in more than one mailbox.

Creating Mailboxes During Transfers
You can create a mailboxes and transfer your message into it at the same 
time; just choose “New...” instead of the name of a mailbox. The 
following box will appear:

Figure 9.2. New mailbox dialog.

Type in the name and click the “OK” button. The mailbox will be created 
and added to the Mailbox and Transfer menus, and the current message 
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will be transferred into the new mailbox.  (If you 
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check the “Don’t transfer, just create” box, the mailbox will be created, 
but the message won’t be transferred into it.)

You can also create mailboxes using the Mailboxes window (see Section 
10).  The Mailboxes window is most useful if you want to create several 
mailboxes, or want to create mailboxes but don’t have any mail to transfer 
into them just yet.

Creating a New Mail Folder During Transfer
Some people may want greater flexibility in organizing and categorizing 
their incoming mail.  Eudora allows you to create mail folders, in which 
you may keep one or more mailboxes and even other sub-folders that hold 
additional mailboxes.  In other words, not only can mailboxes be 
organized into folders, but folders can be contained one within another.  
This hierarchical system of nested folders and mailboxes is easy to 
construct.

To create a new mail folder, follow the steps for creating a new mailbox 
above. Type the name you want the new mail folder to have, click on the 
“Make it a Folder” box and then click “OK”  (see Figure 9.3).

Figure 9.3. Creating a mail folder.

The new folder name will appear at the bottom of the list of mailbox 
names that appear under the Mailbox and Transfer menus, with an arrow 
next to its name, designating it as a folder and not as a mailbox.  Your 
message can’t be transferred, however, since messages must be in 
mailboxes and you have not yet created a mailbox, but only a folder.  
Therefore, the new mailbox dialog will appear again.  Now, type the name 
of the mailbox you want to create and click “OK”.
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Figure 9.4. Creating a mailbox inside the new mail folder.

The mailbox will be created inside the folder you created in the previous 
step, and your message will be transferred into it.

Creating Within a Sub Folder
To create a new mailbox within a particular folder, choose  “New...” from 
the sub-menu that appears when you select that folder from under the 
Transfer menu.  The same dialog box as shown in Figure 9.1 will appear, 
requesting the name of the new mailbox, or mail folder, as you choose to 
make it.

Every folder listed in a menu will have its own sub menu with a “New...” 
command for creating new mailboxes or folders to be placed within it.  
Notice in the Figure 9.5 the selection of the mailbox “Suggestions,” held 
in the “Eudora” folder that is listed under the “Transfer” menu.

Figure 9.5. A mildly complex set of mailboxes.

Mailboxes in sub folders work exactly like other mailboxes; you can open 
them, read messages in them, and transfer mail into them

To remove, rename or move mailboxes and folders around in folders, see 
the next section for a discussion of the Mailboxes window.
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10.  The Mailboxes Window

Mailboxes and mail folders provide a structured way for Eudora users to 
organize received messages.  At some point, you will probably want to not 
only create new mailboxes and folders (one method for which was 
explained in Section 9), but remove them and rename them.  You may also 
want to move mailboxes and folders from one folder to another one.  
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To accomplish any of these tasks, first choose “Mailboxes” from the 
Special menu.  The Mailboxes window will appear.

Figure 10.1. The Mailboxes window.

You will notice two identical list boxes with scroll bars, each entitled 
“Eudora Folder” (or whatever the name of the folder holding your mail is; 
see section 28).

Figure 10.2. The list boxes.

These boxes show the names of mailboxes and folders you have created.   
This list is similar to that which appears under the normal Mailbox and 
Transfer menus, except that the In, Out and Trash mailboxes don’t appear 
in the list.  Underneath each of the boxes are buttons labeled “Rename,” 
“New” and “Remove.”  Between the boxes are two additional buttons 
labeled “Move,” each pointing from one box to the other. 

Double-clicking on any of the mailboxes in a list box will open that 
mailbox window on the screen, and individual messages can be selected, 
opened and otherwise manipulated from there.
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Figure 10.3. Opening a mailbox from the Mailboxes window.

Finding the Mailbox or Folder to be Manipulated
If the Mailbox window isn’t big enough to display all of your created 
mailboxes and folders, use the scroll bars on the right side of either list 
box to peruse the rest of the mailboxes and folders. 

Double-clicking on a folder (folders here, like under the normal Mailbox 
menu, are found at the end of the list and are denoted with arrows to the 
right of their names) will change the current title of the list box from 
“Eudora Folder” to that of the chosen folder.  The contents of the list will 
also be changed to correspond to the names of mailboxes and sub-folders 
contained in the chosen folder (see Figure 10.4).

Figure 10.4. Opening a mail folder.
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To move out from a sub-folder to the folder that contains it, press on the 
inner folder’s title above the listing of its contents, and notice that a menu 
appears of the other outer folders available.  Choosing one of these other 
folder names in the menu will change the list box to reflect that folder’s 
name and contents. 

Figure 10.5. Moving back out of a mail folder.

Removing a Mailbox or Folder
With the Mailboxes window open on your screen, use the scroll bars and 
procedure described above (in the “Finding the Mailbox or Folder to be 
Manipulated” section) to locate the name of the mailbox or folder that you 
want to remove.  

Click once on the desired mailbox/folder in one of the list boxes; this 
selects the mailbox or folder.  Then click the “Remove” button shown 
below it.

Figure 10.6. Starting to remove a mailbox.

A dialog box will then appear to confirm that you want to delete the 
mailbox.  Click on the “Remove It” button to delete the mailbox.
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Figure 10.7. Mailbox removal dialog.

If you press the command (Apple) key while selecting from a list box, you 
can select more than one mailbox or folder simultaneously.  When you 
click on the button labeled “Remove,” the same dialog box will appear to 
verify the removal.  The dialog will contain the name of the first mailbox 
you have selected. If you click on “Remove It,” Eudora will remove that 
mailbox, and then present you with another dialog for the next mailbox, 
and so on.  If you click on “Remove All,” all of the selected items will be 
removed without any further prompts.

If you choose to remove a mailbox in which messages are still stored, or a 
folder in which other mailboxes or folders are stored, a different dialog 
box will verify your intent to delete the mailbox/folder, which would also 
destroy all messages/mailboxes/folders contained therein.

Figure 10.8. Removing a mailbox with messages in it.

Renaming a Mailbox or Folder
With the Mailboxes window open on your screen, use the scroll bars and 
procedure described in “Finding the Mailbox or Folder to 
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be Manipulated” to locate the name of the mailbox/folder that you want to 
rename.

Click once on the desired mailbox/folder in the list.  Then click on the 
“Rename” button that appears below it.  

A dialog box will appear requesting the new name.  Type in the new name, 
click on the “OK” button, and the mailbox or folder will be renamed.

Creating a New Mailbox or Folder
One way to create a new mailbox or folder was explained in Section 9.  If 
you have many mailboxes and folder to create, you may want to use an 
alternative method.

With the Mailboxes window open on your screen, open the folder in which 
the new mailbox/folder is to be created, such that its name is displayed 
above one of the list boxes and its contents are displayed therein.  If you 
are not sure how to do this, refer to the procedure described in “Finding 
the Mailbox or Folder to be Manipulated” sub-section above. 

Click on the “New” button that appears below the list box.  

Figure 10.9. Starting to create a new mailbox.

A dialog box will appear requesting the name of the new mailbox.
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Figure 10.10. Naming a new mailbox.

Type in the new name, check the box marked “Make it a Folder” if you 
want to do so, and click “OK.”  The new mailbox/folder will appear in the 
designated folder’s listing, and if you close the Mailboxes window, you 
will also be able to find the newly created mailbox/folder in the Mailbox 
and Transfer menus.

Figure 10.11. The new mailbox appears.

Moving a Mailbox (or Folder) from one Folder to Another
The Mailboxes window provides the only means for moving mailboxes 
and folders to other folder locations.  This is why there are two list boxes 
in the window.

To begin, locate in one of the list boxes the folder or mailbox which you 
want to move.  In the other list box, find and open (by double-clicking on 
the name) the destination folder such that its name is displayed above the 
box and its contents are displayed below it.  Then, select the mailbox or 
folder you want to move.   Now click on the “Move” button that points 
from the list box containing the item you want to move to the list box 
displaying the destination folder.  The chosen mailbox/folder will be 
moved to its new location. 
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Figure 10.12. Moving a mailbox, before and after.

11.  Attaching a Macintosh Document to an Outgoing 
Message

Any Macintosh document may be attached to and sent with a message 
generated with Eudora.

The outgoing message to which the document is to be attached must be 
open and the selected window.   Choose “Attach Document...” from the 
Message menu.  A “Standard File” dialog will appear (see Figure 11.1).  
Once the desired document is located, select it (with the “Open” button or 
by double-clicking the mouse cursor on the document’s name) and the 
document will be attached to the message. 
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Figure 11.1. Attaching a document.
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Any attached document is like a “rider” to the e-mail message, and thus 
will not be seen by you (the sender) within the message text.  Instead, the 
name of the document and the disk from which it was copied will appear 
automatically in the “Attachments:” field of the message header (see 
Figure 11.2).

Figure 11.2. An outgoing message with an attached document.

Note: A document can not be appended to a message through 
manual editing of the “Attachments:” field.

When the message is sent, if the chosen document is not a plain (ASCII) 
text file, it will be formatted in BinHex 4.0 format and sent with the 
message.  This allows you to send any kind of document through the mail, 
even Macintosh applications.

If the chosen document is a plain text file (and if you have not selected 
“BinHex ‘TEXT’” in the “Switches...” dialog or in the icon bar), it will 
not be encoded in any special format before being sent, but rather will be 
added to your message as though you had typed it.

Multiple Attachments
Multiple documents may be sent with a single message, but the above 
process must be repeated separately for each document to be attached.

Detaching a Document
To detach a document before the message is sent out, click anywhere on 
the name of the document in the “Attachments:” field of the composition 
window.  Then press the “delete” key, or choose “Clear” from the “Edit” 
menu.

QUALCOMM Incorporated Eudora Reference Guide



Eudora Reference Guide QUALCOMM Incorporated

Figure 11.3. Removing an attachment from a message.

Receiving an Attached Document
There are two primary ways you can receive an attached document from 
another Eudora user.  One way prompts you to choose in what folder the 
attachment should be placed as well as to assign the attachment’s name, 
and the other way automatically receives all attachments in a pre-specified 
folder on your disk.

Manual Receive of Attachments
Unless you choose “Automatically save attachments to” in the 
“Configuration...” dialog box, whenever you receive a message with an 
attachment from another Eudora user, a “Standard File” dialog will appear. 
Use this dialog to choose where to put the document and what to call it.

Figure 11.4. Manually receiving an attachment.
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Eudora will automatically decode the attachment, and it will arrive on 
your disk just the way it left the sender’s.

Not Saving an Attachment
You may choose not to save the attached document.  This is done by 
clicking the “Cancel” button in the above dialog.  In such a case, the 
attachment will appear in the body of the message. The document will 
have to be saved to a file and decoded manually to appear in its proper 
format.

Note: The application “StuffIt”, among others, may be used to 
decode such documents.

Saving Attachments Automatically
The most convenient way to save attachments is to a pre-specified folder 
on your disk.  To set this up, select “Configuration...” from the Special 
menu.  Then, in the dialog box, click on the large blank button beneath 
“Automatically save attachments to:” (see Figure 11.5).

Figure 11.5. Starting to set an attachments folder.

Another dialog box will appear, through which you may choose the folder 
in which arriving attachments will be automatically saved.
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Figure 11.6. Choosing an attachments folder.
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This is another “Standard File” dialog, but one that shows only folders.  
Move until the name of the folder into which you want Eudora to put 
attachments is shown in the menu at the top of the box. At this point, click 
on the “Use Folder” button to the right of the menu box, designating the 
folder as the one to receive attachments.  

This dialog box will then close, leaving the “Configuration...” dialog 
displayed.  Notice that the name of the folder you just selected to receive 
attachments is now shown in the button.  If you ever want to specify a 
different folder to receive attachments, simply click on this button 
(showing the name of the presently chosen folder) and the associated 
dialog box for making a change will appear.  

In order for the folder to be used, the small box to the left of 
“Automatically save attachments to:” must also be checked.  Eudora will 
check this for you when you select a folder.

Figure 11.7. An attachments folder is now set.

Note: If at some future time Eudora cannot find your selected 
folder (perhaps because the volume that contained it is not 
available), it will uncheck the “Automatically save 
attachments to:” box, but leave the name of the folder in 
the button.

When invoking this option, attachments will be decoded directly into the 
folder, without intervention from you.  The name given your attachments 
will be recorded in the message from which they came.  If you receive 
multiple attachments with the same name, a number will be added to each 
attachment’s name.

Non-Eudora Users Receiving Attachments
If you send an attachment to someone who doesn’t receive e-mail with 
Eudora, the attached file will appear at the end of the message, in either 
ASCII or BinHex format, depending on how you chose to send it.  If it is 
encoded in BinHex, it will not be usable until the recipient has decoded it.

Note: The application “StuffIt”, among others, may be used to 
decode such documents.
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12. Replying to, Forwarding or Redirecting an 
Incoming Message

Replying to a Message
To reply to a current message, select “Reply” from the Message menu.  A 
new message window will appear, with the original sender’s address 
automatically placed in the “To:” field of the header, making it the 
destination address of the new message.  The original sender’s text will 
also be automatically included in the beginning of the message (prefixed 
by “>”  at the beginning of each line) for reference.  This text may be 
edited as needed.  Since it is fully selected in the new composition 
window, it can be easily deleted; just press the “delete” key.   Additional 
text may be entered into the reply just as in any outgoing message.  The 
reply then can be saved for further changes, or simply sent (see Figures 
12.1).
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Figure 12.1. A message and a reply to it.

An incoming message for which the “Reply” command has been used will 
be marked by an “R” in its message summary.

Figure 12.2. ‘R’ indicates that a message has been replied to.
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Modified Forms of Reply
There are several variations of the reply command.

Reply all: If you hold down the “option” key when choosing “Reply,” the 
message will be sent to everyone who received the original message, not 
just the person who sent the original message.  This is useful for carrying 
on group discussions electronically.  If you have the “Reply All” option 
selected in the “Switches...” dialog, reply all will be the default, and you 
must hold down the “option” key to reply only to the sender.

Don’t include self: If the “Include Self” option is not selected in the 
“Switches...” dialog, Eudora will not include your return address when 
doing reply all.

Note: If you have more than one return address, create a 
nickname called “me”, and put all your addresses in the 
“Address(es):” box (refer to section 13, Nicknames.

Quote selection only:  If you hold down the “shift” key while replying 
to a message, only the text you currently have selected will be quoted in 
the new message.

Figure 12.3. A message to be replied to. Note that the line “This is a test.” is 
selected.
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Quote whole message.  (Default) Quote selection only.  (Hold down 
"shift" key.)

Reply to sender.

or

+ hold down 
“option” key

Reply to all except 
self.

or

+ hold down 
“option key”

Reply to all 
including self.

or

+ hold down 
“option key”

Figure 12.4. The six possible forms of reply.

Forwarding a Message
You may want to relay, or forward, information you receive via e-mail to 
other users.  To do this, for any current received message, select 
“Forward” from the Message menu.  This will transfer the body of the 
received message to a new message window.  There you must fill in the 
empty “To:” field in the message header with the address of the person to 
whom the message should be forwarded.  In addition, not only is the 
original message text included, but the header of that message is included 
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as well, all denoted with “>” markers at the beginning of each line.  The 
existing text may be edited and more text may be added to the message.  A 
forwarded message is marked (in the “From:” field) as coming from you.
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Figure 12.5. Forwarding a message.

An incoming message for which the “Forward” command has been used 
will be marked by an “F” in its message summary. (see Figure 12.6).

Figure 12.6. ‘F’ indicates that a message has been forwarded.

Redirecting a Message
Eudora provides a way to shunt messages that you decide were more 
appropriately sent to someone beside you.  This is referred to as 
“redirecting” a message.  
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To do this for any current incoming message, select “Redirect” from the 
“Message” menu.  A new message window will appear, and you should 
type in the appropriate recipient in the “To:” field of the header.   The 
address in the “From:” field will automatically be that of the person who 
originally sent the message, “by way of” your address.  In addition, there 
will be no “>” markers at the beginning of each line of the original text.  
You may however edit or add more text to the message.
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Figure 12.7. Redirecting a message.

An incoming message for which the “Redirect” command has been used 
will be marked by a “D” in its message summary. (see Figure 12.8).

Figure 12.8. ‘D’ indicates a message has been redirected.

Redirect and Signatures
When you use “Redirect,” your signature file (described in Section 23) 
will not be appended to the message when it is sent, unless the message 
was originally from you (an example of the latter case is explained in the 
Easy  Repeat section below).  Eudora considers the message to be 
originally from you if the address in the “From:” field exactly matches 
your return address setting (or if you have not entered a return address, 
your POP account setting) as entered in your Eudora Configuration; see 
Section 24.  

Easy Repeat (“Canned”) Messages
If you find yourself sending the same message over and over again to 
different people, you can keep a “canned” copy of that message, and send 
it easily using the “Redirect” command.  To do this, first compose a new 
message as you normally would, but leave the “To:” field blank.  Save the 
message, then use the “Transfer” menu to put it into another mailbox 
(named “Canned Messages,” perhaps).  When you want to send the 
message to someone, open 
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the message from the “Canned Messages” mailbox, choose “Redirect” 
from the “Messages” menu, fill in the “To:” field, and send the message.  
This can save you a lot of time and typing.

Figure 12.9. Using a mailbox for frequently sent messages.

Note: The “Reply,” “Forward” and “Redirect” commands are 
different from the “Reply To,” “Forward To” and 
“Redirect  To” commands found under the same Message 
menu.  The latter set of commands are used with a “quick” 
recipient list and are described in Section 14.

Figure 12.10.  Reply and Reply To are not the same.
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13. Creating and Using Nicknames

Nicknames, sometimes called aliases, can be used within Eudora.  A 
nickname is an easily remembered, shorter substitute for an actual e-mail 
address or a group of addresses.  Typically, nicknames are created for 
persons with whom one has repeated 
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correspondence, and hence serve as a typing and reference shortcut.  
Eudora allows nicknames to be used in place of proper e-mail addresses in 
the “To:,” “Cc:,” and “Bcc:” fields in the headers of outgoing messages.

To create, edit or remove a nickname, first select “Nicknames...” from the 
Special menu.  The Nicknames window will appear.  It is divided into 
three main sections:  a list box (that shows all your nicknames), an 
“Address(es)” box (that shows the nickname’s expansion —the addresses 
that a nickname represents), and a “Notes” box (for your private notes on a 
nickname).  Command buttons also appear at the bottom of the window.

Figure 13.1. The Nicknames window.

Adding New Nicknames
To add a new nickname, click the “New” button.  You will be asked for the 
name of the new nickname.

Figure 13.2. Naming a new nickname.
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Type the name you want the nickname to have.  If you want the nickname 
to show up on the “Quick Recipient” lists (see Section 14), click “Put it on 
the recipient list”.  Click “OK”.

Your nickname will appear in the list box of the Nicknames window, and 
the insertion point will be placed in the “Address(es)” box.  Type the 
complete e-mail address of the person to be represented by the nickname 
(see Figure 13.3).

Figure 13.3. Entering an address for a nickname.

If you’d like to add someone’s proper name to the address that you 
specify, just put it in parentheses after the e-mail address; for example,  “s-
dorner@uiuc.edu (Steve Dorner)”.

Figure 13.4. Entering a real name for a nickname.

Note: Be aware that such proper names will be put in your mail 
messages.  “(My Boss Mush-For-Brains)” is probably not 
a good idea here.
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You may also type a series of many e-mail addresses (and even other 
nicknames), separated by commas or returns, in the “Address(es)” box.  
These multiple addresses will be represented by the single entered 
nickname.  In this way, a nickname can be used for a group mailing list 
(see Figure 13.5).

Figure 13.5. Using a nickname as a mailing list.

Note: The Nicknames window is the only place where it is 
permissible to use returns to separate addresses.  
Everywhere else, you must use commas.

The Notes box may be used to enter any text you’d like to associate with a 
nickname, such as the addressee’s company, title, or phone number.  Click 
in it and type whatever you want.

Figure 13.6. Entering notes for a nickname.

Note: What you type in the Notes box will not be put in mail you 
send.  This is the place to let old Mush-For-Brains have it.
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One nickname can point to another nickname, which can point to still 
another, and so on; eventually, however, the nickname must end in a real 
address or group of addresses.  For example, “alphas” contains “john” in 
its expansion, and “john” is itself a nickname for “j-norstad@nwu.edu”.

Figure 13.7. One nickname using another nickname.

Once you’ve finished typing addresses and notes, you can click the “New” 
button again to make another nickname.

When finished making additions or changes, close the Nicknames 
window.  A dialog box will then appear asking whether the 
additions/changes you made to the nicknames should be saved or 
discarded.

Figure 13.8. Saving changes to the nicknames.

Changing and Removing Nicknames
To remove a nickname or change it or its corresponding e-mail 
address(es), click on the nickname from the list box.  The addresses and 
notes associated with the nickname will appear in the “Address(es)” and 
“Notes” boxes; these may be directly edited.
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Figure 13.9. Changing a nickname expansion.

If you want to change the nickname itself, click the “Rename” button.  A 
dialog box will appear allowing you to change the nickname.  You may 
also add or remove the nickname from the “Quick Recipient” list with the 
“Put it on the recipient list” check box.  Click “OK” to accept your 
changes.

Figure 13.10. Renaming a nickname.

To remove the nickname, click the “Remove” button.

When finished editing or making deletions, close the Nicknames window. 
A dialog box will appear asking if the changes should be saved or 
discarded. You can also choose “Save” from the File menu to save the 
nicknames.

QUALCOMM Incorporated Eudora Reference Guide



Eudora Reference Guide QUALCOMM Incorporated

The “Make Nickname” Command
The “Make Nickname...” command under the Special menu can be used to 
make a nickname in two different ways.
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From the Nicknames window itself, command-click to select several 
different nicknames, and then choose “Make Nickname”.  You will be 
asked for the name of the new nickname, and a nickname will be created 
with the selected nicknames as its addresses.  This is an easy way to make 
a group nickname out of existing nicknames.

Figure 13.11. Using “Make Nickname...” to make a mailing list.

Alternately, you can make a nickname out of the address list of any current 
messages.  With a message current, choose “Make Nickname”.  You will 
be asked for a name for the new nickname.  If the current message is an 
outgoing message, its To:, Cc:, and Bcc: fields will be used for the 
nickname’s expansion.  If the current message is an incoming message, 
Eudora will use the “From:” field for the expansion.  If multiple messages 
are current (i.e., you have several message summaries selected in a 
mailbox window), addresses will be taken from each message, and all put 
in the new nickname’s expansion.
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Figure 13.12. Making a nickname from current messages.

Note: When an incoming message is current, “Make Nickname” 
really pretends to do a “Reply” to the current message, 
and then takes all the recipients from the reply message 
and uses them in the nickname expansion.  This means that 
“Make Nickname” acts just like “Reply” in regard to the 
“Include Self” and “Reply All” options.  That is, if you 
have “Reply All” selected in the “Switches...” dialog (or 
hold down the option key), the nickname will be made for 
all the recipients of the messages plus the sender, not just 
the sender.  Similarly, if “Include Self” is not selected in 
“Switches...”, your address will not be included in the new 
nickname’s expansion.

Using the Nicknames Window to Address Mail
The other three buttons in the Nicknames window can be used to start mail 
messages or to add addressees to existing messages.  First, select the 
nickname to which you want to address the mail (you can select multiple 
nicknames by holding down the command [Apple] key and clicking on 
each nickname).  Then, click the “To:”, “Cc:”, or “Bcc:” button to insert 
the nickname into the corresponding field.
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Figure 13.13. Starting a new message from the Nicknames window.

If the window beneath the Nicknames window is a composition window, 
the addresses will be added to it, including any necessary commas.  If the 
window beneath is not a composition window, a new composition window 
will be started, and the addresses inserted into it.

Figure 13.14. A message pre-addressed from the Nicknames window.

Type-to-Select in the Nicknames window
When the bold square is around the list box (indicating that the list box is 
selected), typing the first few letters of a nickname will select that 
nickname.  If the bold square isn’t around the list box, just click on it.
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Figure 13.15. Type-to-select.

Nicknames and the Quick Recipient List
Nicknames and the Quick Recipient list are two separate entities.  
Nicknames are used as an abbreviation for an address or a list of 
addresses.  The Quick Recipient list is used as a way to put addresses into 
a message by means of a menu.  Nicknames need not be on the Quick 
Recipient list, and not everything on the Quick Recipient list need be a 
nickname.

However, you may have some nicknames to which you often send mail, 
and it makes sense to put these nicknames on the Quick Recipient list.  
This is easily done from the Nicknames window.

Examine the list box in the Nicknames window.  You will notice that there 
is a margin between the first letter of each nickname and the edge of the 
box.  Now, select a nickname and place the mouse over the margin 
between the nickname and the edge of the box.  The cursor will turn into a 
miniature picture of a menu.

Figure 13.16. A nickname that isn’t on the Quick Recipient list.
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Click the mouse, and a bullet (“•”) will appear in the margin area.  this 
bullet indicates that the nickname has been put on the Quick Recipient list.

Figure 13.17. The nickname is now on the Quick Recipient list.

Click again, and the bullet disappears, removing the nickname from the 
Quick Recipient list.  The Quick Recipient list is discussed further in the 
next section.

Note: Double-clicking a nickname also puts it on or removes it 
from the Quick Recipient list.

Note: If you rename or remove a nickname that is also on the 
Quick Recipient list, the name on the Quick Recipient list 
will also be changed or removed.

“Finish Nicknames” Command
There is yet another nickname-related function designed to save typing 
effort in header fields.  It allows you to type only in a portion of a 
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nickname in a field of a message header, with Eudora completing the 
typing task. 

To use this option, when entering a nickname in the “To:,” “Cc:,” or 
“Bcc:” fields of a message, it is only necessary to type in the number of 
characters in the nickname that make it unique with respect to other 
nicknames.  Then select “Finish Nickname” from the Edit menu, and the 
partial text of the nickname will be automatically completed in the header 
field.

For example, given the list of nicknames shown in the Nicknames window 
of Figure 13.13, you could enter the characters “al” in the “To:” field of an 
outgoing message header, and then select “Finish 
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Nickname” from the “Edit” menu, which would insert the complete 
nickname “alphas” (see Figure 13.18).

Figure 13.18 Finishing a nickname.

Note: If you hold down the option key while finishing a nickname,  
the nickname’s expansion will be inserted, instead of the 
nickname itself.

14.  Using the Quick Recipient List 

You may more conveniently address a message by selecting a nickname or 
full address from a predetermined Quick Recipient list.  Using it 
eliminates the need to type commonly used nicknames or addresses in the 
fields of outgoing message headers.  By selecting (with the mouse) a 
nickname or address from the Quick Recipient list,  the address or 
nickname is automatically entered in the desired field.  The list may also 
be used to more easily reply to, forward or redirect messages. 
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Figure 14.1. The Quick Recipient list.  

Creating the Quick Recipient List
The Quick Recipient list should consist of the nicknames or addresses of 
common correspondents.

To put a nickname on this list, choose “Nicknames” from the Special 
menu (for a discussion on the Nickname feature, see Section 13).  The 
Nicknames window will appear.  Select the desired nickname or 
nicknames from list box on the left side of the window.  Then, click in the 
margin between the first letter of the nickname and the left side of the list 
box.  This will put a bullet in the margin of the window, and add the 
nickname to the Quick Recipient list.

Figure 14.2. Adding a nickname to the Quick Recipient list.

To put a full e-mail address on the list, select the desired text that makes 
up the address from any message (see Figure 14.3), and then choose “Add 
As Recipient” from the Special menu.
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Figure 14.3. Adding an address to the Quick Recipient list.

Using the Quick Recipient List
The Quick Recipient list appears when you choose “New Message To,” 
“Reply To,” “Forward To,” or “Redirect To” from the Message menu.  
Choosing a recipient on the Quick Recipient list of one of these commands 
will perform the action (new message, reply, forward, redirect) but with 
the chosen recipient automatically inserted in the “To:” field of that 
message.

Figure 14.4. Starting a message with the Quick Recipient list.

More than one nickname or address from the Quick Recipient list can be 
added to the “To:” field of the same message, or to any field (i.e. “Cc:” 
and “Bcc:”) of any message.  To do this, first make sure that the blinking 
insertion point is placed in the field where you want the nickname/address 
to be inserted.  Then select the desired 
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recipient from Quick Recipient list appearing under “Insert Recipient” in 
the “Edit” menu.  The chosen nickname/address will be placed at the 
insertion point.  A comma will be added  (if necessary) to separate the new 
address from the ones in the field already.

Removing a Quick Recipient From the List
A nickname/address entry may be removed from the Quick Recipient list 
by selecting it from the “Remove Recipient” item from the Special menu.

Figure 14.5. Removing a name from the Quick Recipient list.

15.  Finding Specified Text Within Messages

To quickly locate a bit of text within messages, use the “Find” command 
from the Edit menu.  This will reveal a sub-menu of commands.  These 
commands may be used to find specified texts within single messages, 
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multiple messages or even multiple mailboxes.  

Finding Text Within One Message
To locate certain text within a message, first open that message from its 
mailbox.  Then choose “Find-> Find...” from the “Edit” menu.  (“Find-
>Find...” is shorthand for “the ‘Find...’ item from the ‘Find’ sub-menu.)

The “Find” dialog box will appear, with a blinking 
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insertion point in the box where you may type in the sought-after text.  

Figure 15.1. The “Find” dialog.

Alternatively, if you don’t want to actually type in the text, you may select 
(highlight) it from another message, and then choose “Enter Selection” 
from the “Find” command sub menu (under the Edit menu).  This will 
automatically insert the selected text at the insertion point in the “Find” 
dialog box.

Up to 255 characters may be entered in the blank box (the text will 
automatically scroll to the left if you type beyond the width of the box).  If 
you want to search for the exact match of upper and lower case letters as 
you have entered them, check the option “Match case” in the “Find” 
dialog box.  When finished entering the desired text, click the “Find” 
button.

Starting at the insertion point of the open message, Eudora will search the 
message for the specified text.  If no match is found, the “not found” 
dialog will be shown.

Figure 15.2. Unsuccessful search.

If the search is successful, the message will be scrolled to the first point 
where a match was found, and the matching text will be highlighted.
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Figure 15.3. Successful search.

Note: The mailbox containing the message will be checked in the 
“Mailboxes” menu.

To continue searching in the same message for the next occurrence of the 
text, again click the “Find” button in the “Find” dialog box, or 
alternatively select “Find-> Find Again” from the Edit menu.  These 
commands are equivalent and limit the search to the same message.  
Repeating these commands will cycle through the matches in the open 
message only.

Figure 15.4. Use the “Find” button or “Find Again” command  to search  
within the topmost message only.

Finding Text Among Multiple Messages and Mailboxes
The “Next” command is found either in the “Find” sub menu (under the 
Edit menu) or as a button in the “Find” dialog box (resulting from “Find 
-> Find...” under the Edit menu).  Selecting it will search for the next 
match of the specified text until it can be found either in the same message 
or among all messages in the mailbox.  
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Figure 15.5. Use the “Next” command or button to find the next occurrence in  
or after the topmost message.

Alternatively, selecting the “Next Message” command will begin the 
search at the message after the current message.  Eudora will continue to 
search until it finds a matching message, even if it has to open more than 
one message or a new mailbox.

Figure 15.6. Use the “Next Message” command or button to skip the rest of the  
occurrences in the topmost message.

The “Next Mailbox” command will begin the search for the specified text 
in the mailbox following the current mailbox.  The search will be 
conducted among all messages in that mailbox or any subsequent 
mailboxes.
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Figure 15.7. Use the “Next Mailbox” command or button to skip the rest of the  
occurrences in the mailbox containing the topmost message

Note: The “Find” command initiated on an open mailbox (even 
with message[s] selected) will search for the specified text 
among all messages contained in that mailbox; the search 
does not begin with, nor is it limited to, the selected 
messages.

Summaries Only, Match Case
If you know the text you’re looking for appears in a message summary, 
you can click the “Summaries Only” check box.  This will make Eudora 
look for the text only in the sender and subjects of messages as they 
appear in mailbox windows. Eudora searches much faster when this option 
is checked.

Figure 15.8. The “Summaries only” option makes Eudora search only message  
summaries, not bodies, which is much faster.

Normally, Eudora ignores capitalization when searching.  If you want 
Eudora to consider capitalization when searching, check the “Match case” 
box.

Figure 15.9. Making Eudora care about capitalization.
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Stopping a Find
If you want to stop Eudora from continuing a search, just hold down the 
command (Apple) key and press period. 

16.  Sorting Messages Within Mailboxes

It is possible to sort the message summaries in a mailbox window 
according to their status, priority, sender, date, or subject.  These 
commands are listed in the sub menu “Sort” in the Edit menu.

To use any of these commands, first open the mailbox to be sorted.  Then 
choose the appropriate command from the Sort sub menu to rearrange the 
order of the mailbox’s listed messages.

Eudora normally sorts in ascending order; the smallest item first. To sort in 
descending order hold down the option key while choosing the desired 
command from the Sort sub menu.

Tip: Eudora’s sorting algorithm is “stable”.  This means that 
sorting on a particular column leaves items of the same 
value in the same order as they were before the sort.  The 
practical upshot of this is that you can sort on multiple 
criteria by using multiple sort commands.  For example, if 
you want your messages sorted by subject, and within each  
subject you want messages sorted by date, you first choose 
“Sort by Date”, then “Sort by Subject”.

Note: Sometimes it seems as if Eudora does not sort by date 
properly.  This can happen if the mail was stored under an 
older version of Eudora, and the table of contents was 
rebuilt, or if the messages have incorrectly formatted date 
fields or unknown or incorrect time zones.
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17.  Saving A Message to a File

Eudora allows you to save the current message(s) to a separate text file on 
your Macintosh system.  

Choose “Save As...” from the File menu.  A “Standard File” dialog will be 
displayed which will allow you to choose a name and location for the file. 
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Figure 17.1. Saving a message to a plain text file.

Note the two options at the bottom of the dialog box.  “Guess Paragraphs” 
instructs Eudora to remove extraneous carriage returns from the message, 
leaving returns only at the ends of paragraphs.  In addition, it converts 
multiple spaces into TAB characters. 

Figure 17.3. “Save As...” without “Guess Paragraphs.”  Note lines don’t reflow evenly.
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Figure 17.4. “Save As...” with “Guess Paragraphs.”  Note proper reflow of  
lines.

The other option, “Include Headers,”  instructs Eudora to retain the 
message’s header information (i.e., the “To:.” “From:,” etc., fields) in the 
saved document.  If this is unchecked, only the body of the message will 
be saved.  While these options may be selected and de-selected with each 
message you save to a file, their default settings are determined by  the 
“Guess Paragraphs” and “Include Headers” options in the “Switches...” 
dialog (see Section 25). 

Having made all of your choices, click on the “Save” button in the dialog 
box.   If you select multiple messages from a mailbox window and choose 
“Save As...”, all of the messages will be saved to a single file.

Figure 17.5. Using “Save As...” to save several messages to one file.

Tip: When Eudora receives a very large message from the POP 
server, it splits that message into multiple 
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smaller messages. If you need to reassemble the original message, 
use the “Save As...” command.

Choosing the Application for Saved Messages
When you save a message to a file with the “Save As...” command, the 
new text file will be formatted as basic ASCII text in a Macintosh 
document.   The document type is determined by the program you choose 
through the “Application TEXT Files Belong To”  setting in the 
“Configuration...” dialog.  

To do this, choose “Configuration...” from the Special menu.  The 
“Configuration...” dialog box will appear.  Near the bottom, click the large 
button beneath the option “Application TEXT Files Belong To”.

A “Standard File” dialog will appear. Search through your disk to find the 
application (probably your favorite word-processing program) which you 
want to use to open messages saved as text files.  Click on the application, 
and click on the “Open” button.
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Figure 17.6. Choosing an application to open the files “Save As...” creates.
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Figure 17.6. Choosing an application to open the files “Save As...” creates.  
(continued)

18.  Re-Sending Rejected Messages 

Mail Transport Agents are computer programs responsible for routing e-
mail messages through networks.  If for some reason an e-mail message 
can’t be delivered to a given intended recipient, these programs will return 
the message to the original sender.  A message will typically be rejected 
because of an error in the recipient’s address, although many other reasons 
are possible.

The message sent back from the mail system usually includes cryptic 
information from which you may be able to discern the reason for the 
message being rejected.  It also includes the text of the original message.  
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Figure 18.1. A rejected message.

Eudora allows you to strip out the error message and excess text, and 
recover the original message so that you can make any 
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corrections and re-send it.  To do this for the current message, choose 
“Send Again” from the Message menu.  This will eliminate the inserted 
extra text and reformat the message as it originally appeared.   Changes 
and additions may then be made, followed by another attempt to send the 
message if you so want.

Figure 18.2. A rejected message, redeemed.

19.  Message Priorities

Eudora allows you to set priorities on your messages.  These priorities are 
for your reference on incoming messages, and as hints to your recipients 
on outgoing messages.  There are five priority levels available, each 
represented by a small icon (see Figure 19.1).  Priorities range from 1 
(highest) to 5 (lowest).  Priority 3 is assumed for messages that have no 
assigned priorities, and is not displayed.

Highest priority
High priority
Normal (blank)
Low priority
Lowest priority

Note: Priorities don’t mean anything to the mail transport 
system; your mail won’t arrive any faster or slower if you 
change its priority.  Priorities are for reference purposes 
only.

To change the priority of a message, open the message, and choose the 
desired priority from the menu that pops up when you press on the box on 
the left side of the icon bar.  The priority icon will then appear in the 
priority box, and the message’s priority will be changed.
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Figure 19.1. Assigning a priority to a message.

Figure 19.2. A message with a priority assigned to it.

You can also change the priority of the current message(s) by holding 
down the command (Apple) key, and pressing a number keys from 1 to 5 
(1=Highest; 5=Lowest).

When Eudora sends mail with a priority other than Normal, it adds an X-
Priority header to the mail.  The header lists the numerical priority, and a 
description in words.  When mail arrives in Eudora with such a header, 
Eudora assigns the given priority to the message.
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Figure 19.3. An incoming message with a pre-assigned priority.

Note: All new messages are created with Normal priority, even 
replies to messages whose priority you have changed. The 
exception to this rule is that, if the sender of a message 
gave it a priority other than normal, Eudora will insist on 
giving your reply the same priority as the sender gave 
his /her message.  This occurs even if you reassign the 
priority of the sender’s message. You can, however, 
override the priority by one of the methods listed above.

20.  Editing Subjects

Sometimes the subject of an incoming message is not descriptive.  Eudora 
allows you to change the subject as it appears in message summaries.  For 
this to work, the “Icon Bar” option must be checked in the “Switches...” 
dialog.

To change the subject of an incoming message, open it from its mailbox 
window.  Notice that the subject is displayed below the title bar and above 
the message proper.  You may edit this text as you would any other text, by 
clicking and typing in it.  When you’re done making changes, hit the 
“Enter” key or close the message.  The new subject will be displayed in 
the message summary.  (The subject as it appears in the message itself, 
however, is unchanged.)
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Figure 20.1. Editing the subject of a message.

Figure 20.2. After Editing the subject.

Note: If you reply to the message, the original subject will be 
used for the reply, not your changed subject.  This gives 
you the freedom to put information useful to you into the 
summary, without fear of your private notes being revealed 
to your correspondents.
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21.  Printing

Eudora can print the current messages, or a plain text window, or the 
contents of the ph window.  Simply choose “Print...” from the 
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“File” menu, like in any other Macintosh application.  If you have text 
selected in the window, you can print just the selected text using the “Print 
Selection...” menu item.

Eudora prints headers and footers on each page, giving the window title, 
page number, and your return address.

22.  Using the Ph Window

Eudora can access two different directory services, “Ph” and “Finger”, by 
means of the Ph window.  To open the Ph window, choose “Ph” from the 
Special menu.

Figure 22.1. The “Ph” window.

The window has two buttons (one for “Ph” and one for “Finger”), and two 
text boxes (one where you type your query, and one where you see the 
response).

Note: If you press return or enter, Eudora will perform whichever  
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button has the bold outline, which will be whichever button  
you last used.

Using Ph
To use the “Ph” protocol, you must first type the name of a “Ph” server 
into the “Ph Server” box in the “Configuration...” dialog.

Type the name you want to look up in the query box, and press the “Ph” 
button.  The server’s response will be printed in the response box.
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Figure 22.2. A “Ph” query and its response.

Note: You can type any ph command in the query box, except 
login commands, or commands requiring login.  For more 
information about “Ph”, see Appendix A.

Using Finger
To use the “Finger” protocol, type your query into the query box.  This 
query should be of the form “name@domain”.  If you omit the 
“@domain” part, Eudora will assume you mean your SMTP server host.  
Click the “Finger” button.

The finger query will be sent to the host specified in the “@domain” part, 
and the response will be put in the response box.

Figure 22.3. A “Finger” query and its response.

Note: Finger servers return a wide variety of information.  
Expect the unexpected.
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23.  Creating a Signature

A “signature” is a brief piece of text automatically appended to the end of 
outgoing messages.  It should consist of a few lines giving the sender’s 
full name and e-mail address.  Other pertinent details, such as phone 
number, postal address, or place of employment are sometimes included.  
An example of a “signature” is seen in the message shown in Figure 22.1.

Figure 23.1. A signature.

To create a signature, choose “Signature” from the Special menu.  A blank 
Signature window will then appear; enter you signature text in this 
window.  An example is shown in Figure 22.2.
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Figure 23.2. Editing a signature.

When you are finished editing, close the Signature window; a dialog will 
appear to verify your additions or changes.

You will not see this signature text at the end of messages you create, 
although your recipient(s) will see the signature at the end of your 
messages.

In order to activate your signature on all outgoing messages, be sure to 
select the “Use Signature” option in the “Switches...” dialog (see Section 
25).  If you use the icon bar (see Section 1), you may override that option 
and select or de-select the signature option for each message you send.
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Figure 23.3. Your signature is used if the icon is checked in the icon bar.

You may select “Signature” from the Special menu at any time to change  
your signature file.

24.  The “Configuration...” Dialog

In order for Eudora to work correctly, you must configure the program by 
giving it some basic though important information elements.  To enter this 
information, first select “Configuration...” from the Special menu.  A large 
dialog box will appear.  

Note: There are many settings in this dialog; new users can 
safely ignore all of those below the first horizontal line.

QUALCOMM Incorporated Eudora Reference Guide



Eudora Reference Guide QUALCOMM Incorporated

Figure 24.1. The “Configuration...” dialog.

Each of these settings is described below.  The default setting, if it exists, 
is listed in brackets after the name of each Configuration setting.  

POP account: [none]
To receive mail with Eudora, you must have an account on a computer that 
runs a POP 3 (Post Office Protocol) server.  This is the account to which 
your e-mail messages are delivered before they are transferred to the 
Eudora program on your Macintosh.  In 
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the “POP account” box, enter your login name for this account and the 
(domain) name of the computer, separating them with an “@” sign.

For example, if your login name for your POP account is “carolyn”, and 
the name of the computer was “uxh.cso.uiuc.edu”, you would enter 
“carolyn@uxh.cso.uiuc.edu” in this box.

Note: This item is used differently if you use UUCP as your mail 
transport.  See Appendix F for details.

Real Name: [none]
Enter your real name here.  It will be put in parentheses after your return 
address in your outgoing mail.

Connection Method: [MacTCP]
If you are using Eudora via network connections, “MacTCP” should be 
selected (meaning you are using MacTCP software for communications).  
If you are using Eudora via a modem, “Communications Toolbox” should 
be selected (meaning you are using Communications Toolbox software for 
communications).

SMTP Server: [none]
To send mail, a computer with an SMTP (Simple Mail Transfer Protocol) 
server program is necessary.  You need not have a login on this computer; 
you simply must have access to it through your network.  If the computer 
on which you have your POP account is also an SMTP server, you need 
not put anything in this box.  Otherwise, specify here the name of the 
computer which you want to use as your SMTP server.

Note: This item is used differently if you use UUCP as your mail 
transport.  See Appendix F for details.

Return Address: [none]
If you need to use a different return address than your POP account, enter 
it here.

Normally, Eudora uses your POP Account as your return address.  Some 
sites have special provisions for forwarding mail (e.g., addresses based on 
“ph” aliases). In such a case, the e-mail address you would give to people 
won’t be the same as your POP account address.

Important: If you do put an address here, first test the address 
to be sure that mail sent to it will indeed be delivered to 
you.  If you use an invalid return address, no one will be 
able to reply to your mail, even to notify you that you made 
a mistake.

Check For Mail Every  ?  Minute(s) [none]
If you enter a number in this box, Eudora will check your POP server at 
regular intervals, and transfer any mail it finds to your Macintosh.  The 
number you enter specifies the number of minutes between checks to the 
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POP server.  It’s a good idea to set this at no less than 10 minutes; 
checking mail more frequently than that is an 
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unnecessary drain on your POP server.  This option only works when 
Eudora is running.  Leave it empty to disable automatic checking.

Ph Server: [none]
Enter the host name of your “Ph” name server here.

Note: For more information on “Ph”, see Appendix A.

Dialup Username: [none]
If you use Eudora with the Communications Toolbox, and you have a 
secondary user name for use during the dialup process, enter it here.  (This 
might be used as your login name to a terminal server, for example.)  See 
Appendix D for details on how this user name may be used.

Message Window Width:  [none]
The width (in characters) you would like message windows to be.  If you 
leave this empty, Eudora will assume a value of 80.  This setting affects 
only the width of new and zoomed message windows; it has no effect on 
what your mail looks like when it is sent.  When mail is sent, Eudora 
wraps at or before 76 columns.

Note: If you use a proportional font, Eudora will set the window 
width based on the width of the “0” character.

Message Window Lines: [none]
The number of lines you would like message windows to display.  The 
default number is 20.  (If you have the “Icon Bar” option turned on, you 
will get fewer lines.)

Screen Font, Size: [Mishawaka]
Pressing this item will pop up a menu of screen fonts, from which you 
may choose one for displaying the text of your Eudora messages and 
mailbox windows on screen.  Type the size (in points) of the font you want 
to use in the “Size” box.

Printer Font, Size: [Courier]
Same as above, but this font and size is used when messages are printed 
using the “Print...” command.

Application TEXT files belong to: [TeachText]
When you choose “Save As...” from the File menu, Eudora creates a 
Macintosh document that will “belong” to the application named in the 
button beneath.  That is, when you double-click the saved file, this 
application will open.  You will probably want to set this option to your 
favorite word processing program.  To change the setting, click on the 
button, and a dialog will appear, allowing you to choose the application. 

Automatically save attachments to: [off, none]

QUALCOMM Incorporated Eudora Reference Guide



Eudora Reference Guide QUALCOMM Incorporated

If this option is checked, Eudora will automatically put file attachments 
that come with messages in a folder of your choice (you can change the 
folder designated for attachments by clicking on the button below).  If you 
choose a folder, the name of it will be displayed in the button.  This option 
is discussed in greater detail in Section 11.  

25.   The “Switches...” Dialog

You may tailor many aspects of Eudora to your own needs and 
preferences.  Some of these are set with the “Configuration...” dialog 
described in the previous section.  The others are set with the “Switches...” 
dialog.  (It’s easy to know where to look for a particular setting; if the 
setting can be either on or off, it’s in “Switches...”; if a choice beyond 
“on” or “off” is required, it’s in “Configuration...”.)  Choose “Switches...” 
from the Special menu, and the dialog will appear.

Figure 25.1. The “Switches...” dialog.

Under the sub-title “Composition:”
Icon Bar: [on]
If on, the icon bar will be displayed in the windows of all outgoing 
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messages, and the subject editing area will be displayed in the windows of 
all incoming messages.  The icon bar (discussed in Section 1) allows you 
to easily override some of your option settings for the message at hand 
(the initial settings for these are defined in the “Switches...” dialog).  The 
options (discussed below) represented by symbols in the icon bar are Use 
Signature, Word-Wrap, Tabs in Body, Keep Copy, and BinHex ‘TEXT.’  
The icon bar also allows you to change a message’s priority (Section 19), 
or send or queue the message (Section 3).  On incoming messages, the 
subject edit area allows you to change the subject of the message as it 
appears in the message summary (see Section 20).

Live Nicknames: [off]
If this option is on and the Nicknames window is open, the Nicknames 
window will indicate (with a small triangle)  which 
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nickname best matches the text that you are currently typing.  You must 
stop typing for a moment before the Nicknames window will react.  This 
option is most useful in conjunction with the “Finish Nickname” 
command under the “Edit” menu since  it shows what nickname you 
would get if you were to use “Finish Nickname”.

Word Wrap:  [on]
If this option is on, you do not need to enter a carriage return at the end of 
each line of text you type in an outgoing message.  Your message will be 
formatted with line breaks at about 76 characters per line.  This makes 
your mail more legible to recipients using line-oriented mail systems.  It is 
strongly suggested that you check this box.

Tabs in Body: [on]
If on, hitting the TAB key when in the message body will result in Eudora 
inserting enough spaces to move the insertion point to a multiple of 8 
characters from the start of the line.  This mimics the way tabs work on 
many terminals. Otherwise hitting the TAB key will advance the cursor to 
the “To:” field of the message header.

This option also controls the handling of tabs in text that are pasted into 
the message window and in plain text attachments that are not binhexed.  
If Tabs in Body is on, tabs in such texts will be replaced with the above 
mentioned number of spaces, as though you had typed them in.

Finally, this option also controls what Eudora does with tab characters that 
appear in mail downloaded from your POP server.  If the option is on, 
Eudora will replace these with the appropriate numbers of spaces, like it 
does for typed or pasted text.

It is suggested that you keep this option turned on; otherwise, you may get 
messy results when receiving mail that contains tab characters.

Use Signature: [on]
If Use Signature is on, Eudora will automatically attach your signature file 
(if you have one) to the end of any outgoing message.

BinHex ‘TEXT’: [off]
If this option is on, plain ASCII text files that you send as attachments will 
be encoded in BinHex format; otherwise they will be appended to the 
body of the message without being encoded.

Immediate Send: [on]
If on, choosing “Queue for Delivery” from the Message menu will result 
in the mail being sent immediately.  Also, the rightmost button in the icon 
bar will be labeled “Send,” allowing for the immediate sending of 
outgoing messages by clicking the button.

Keep Copies: [off] 
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If Keep Copies is on, Eudora will leave copies of your sent messages in 
the Out mailbox.  The messages will have an “S” in the Status/Priority 
column of the Out mailbox window, to indicate that they have been sent.  
If this setting is unchecked, Eudora will move messages you send into the 
Trash mailbox after they have been sent.

Reply to All: [off]
If this option is on, choosing “Reply” from the “Message Menu” will 
create a message addressed not only to the sender of the original message, 
but also to all of its recipients.  If the option is off, “Reply” will address 
the new message only to the sender.

You can use the option key to reverse this setting for any given reply.  That 
is, if “Reply to All” is off, holding down the option key while choosing 
“Reply” will reply to all, and vice-versa.

This option also applies to the “Make Nickname” command (see Section 
13).

Include Self: [off]
If this option is on when you do a reply all (see above), your address will 
be left in the address list of the new message.  If the option is off, your 
address will be removed.

To determine who “you” are, Eudora uses the “me” nickname, if you have 
one.  If not, it uses the contents of the POP Account and Return Address 
boxes from the “Configuration...” dialog.

This option also applies to the “Make Nickname...” command (see Section 
13).

Under the sub-title “Save As:”
Guess Paragraphs: [on]
Most mail you receive will consist of many short lines separated by 
carriage returns. Most Macintosh word processors prefer to have carriage 
returns only at the ends of paragraphs. When you choose “Save As...” 
from the File menu to save a message to a text file and this option is on, 
Eudora will remove carriage returns that aren’t at the ends of paragraphs 
in the message.

Note: Eudora can only “guess” where paragraphs end. It’s a 
good guesser, but it will occasionally remove a carriage 
return that it shouldn’t have, or leave one in that should 
have been removed.  Some manual clean-up may be 
necessary.

Include Headers:
When saving messages to text files through the “Save As...” command, 
you have the choice of whether to include the message headers (e.g., the 
“To” and “Subject” fields)  in the text files or not.  Turning this switch on 
will include the header information.
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Under the sub-title “Transport:”
Show Progress: [on]
When this option is on, Eudora will display a small window, called the 
Progress window, at the top of your screen to show you what it’s doing 
when making a network connection or some other long operation.
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Send on Check: [on]
If on, Eudora will automatically send any messages with “queued” status 
whenever it checks for new mail at the POP Server. 

Save Password: [off]
If this option is on, you will no longer have to enter your password to 
check your mail, even if you quit Eudora and restart it again.  Only use 
this option if your Macintosh is in a safe place.

Leave Mail on Server: [off]
Eudora normally transfers your messages from the POP server to your 
Macintosh, and deletes them from the POP server. If this setting is on, 
Eudora will transfer incoming messages to Eudora on your Macintosh, but 
keep copies of those messages on the POP server. See Section 5 for more 
details.

Auto-Ok:  [on]
Many networking problems are temporary. When a problem occurs while 
Eudora is transferring or checking your mail, you will be notified (in the 
way you select from the “Get Attention By” section of the “Switches...” 
dialog, described below). If this setting is on, such notifications will 
automatically go away after a couple of minutes. This allows Eudora to try 
the communication again. This setting is most useful if you have a non-
zero value for the setting “Check for mail every ? minute(s).” 

Skip Big Messages: [off]
If this option is on, Eudora will not download the entire texts of very large 
messages, but will only download the first few lines.  This can be useful 
on slow connections. See Section 5 for details.

Under sub-title “Get Attention By:”
These options control what Eudora does when it is running in the 
background and wants your attention, or when new mail arrives.

Alert: [on]
If on, Eudora will use an alert box.

Sound: [on]
If Sound is on, Eudora will make noise when it needs you.  There are two 
different sounds; one for the arrival of mail, and one for everything else.

Flash Menu Icon: [on]
If this option is checked, Eudora will flash an icon in the menu bar when it 
needs you.  Eudora uses two different icons; a “Mail” flag when you have 
new mail, and an envelope with an exclamation point in it for everything 
else.

        

Figure 25.2.  The new mail and envelope menu bar attention icons.
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Open “In” Mailbox: [on]
This option applies only to the arrival of new mail.  If on, Eudora will 
open the In mailbox when mail arrives, scroll the mailbox to the end, and 
select the FUMLUB (See Section 5 if you want to know what in heck a 
FUMLUB is).  If the option is not on, Eudora won’t do anything special to 
the In box when mail arrives, except add the mail to it.

Under sub-title “Switch Messages With:”
Plain Arrows: [off]
If this option is on and there is a message window open on the screen, the 
arrow keys can be used to close the current message and open the next or 
previous one.  The up and left arrows open the previous message, whereas 
the down and right arrows open the next message.  If this option is off, the 
arrow keys can be used to move the insertion point around in messages.

Note: Even if Plain Arrows is on, the arrow keys do not switch 
messages if there is a composition window topmost on the 
screen.

Cmd-Arrows: [on]
This option allows message switching when the command key is held 
down while the arrow keys are pressed.  As above, up and left open the 
previous message, while down and right open the next message.

Note: Cmd-Arrow key presses do work on composition windows.

Under the sub-title “Miscellany:”
Show All Headers: [off]
Normally, Eudora hides a lot of the routing information that is contained 
in a mail message. If you really want to see such things, check this setting.

Note: If you want to see all headers for just one message, hold 
down the option key when opening the message.

Zoom Windows: [off]
When this setting is on, new mailbox and message windows will 
automatically open to their zoomed size.  The zoomed size is computed on 
a window-by-window basis.  For mailbox windows, zoomed size is just 
wide enough to display the widest summary, and just long enough to 
display all the summaries.  For message windows, zoomed size is just long 
enough to display all of the message, and as wide as the Message Window 
Width setting.  Composition windows zoom to the height specified by the 
Message Window Height setting.

Easy Delete: [off]
Normally, Eudora warns you with a dialog (see Figure 8.1) if you delete 
messages you haven’t read, or transfer queued messages out of the Out 
mailbox (which keeps them from being sent).  If you turn this option on, 
you won’t get those warnings.
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Mailbox Superclose: [off]
If Mailbox Superclose is on, closing a mailbox window will close any 
open messages from that mailbox.

Empty Trash on Quit: [on]
When Eudora quits, it empties the Trash mailbox.  If you are fond of your 
trash, turn this option off; Eudora will only empty the Trash when you 
choose “Empty Trash” from the “Special” menu.

Note: If you want to remove some messages from the trash, but 
don’t want to empty it entirely select the summaries you 
want to delete and choose “Delete” from the “Message” 
menu.  The selected messages will be obliterated.

Easy Open: [on]
If Easy Open is on, deleting or transferring the topmost message will open 
the next message, if the next message has not been read.

26.  Balloon Help
Eudora has balloon help for almost all of its windows and menus.  If 
you’re confused about what something means or what it’s supposed to do, 
choose “Show Balloons” from the Help menu.

Figure 26.1. Help balloons.

Then, put the mouse over the item you need help with. You can leave 
balloon help on while you use Eudora.  To turn Balloon Help off, choose 
“Hide Balloons” from the “Help” menu.

Note: It’s possible to turn balloon help on even when a dialog is 
on screen. If you’re not sure how to respond to a dialog, try  
balloon help.
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27.  Quitting Eudora

To quit the Eudora program, select “Quit” from the File menu.  If you 
have queued messages, or timed messages due to be sent in the next 12 
hours, you will be asked if you want to send them (see “Quitting with 
Queued Messages” in Section 3.)
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28.  Mail Storage

When you first start Eudora, it will create a folder named “Eudora Folder” 
in your System Folder.  In that folder, you will find several files.  While 
you don’t normally need to know anything about these files, it can 
sometimes help to know what’s going on.

Eudora Settings
Your Configuration... and Switches... information is kept here, as well as 
your Quick Recipient list, signature, and the list of windows you have 
open (so Eudora can reopen them the next time you start the program).

Eudora Nicknames
Your nicknames are saved here.

Note: This file is a plain TEXT file in UNIX “.mailrc” format.

In, Out, and Trash
These files hold your mail.  You’ll see files like this for every mailbox you 
create.

Note: These files are in UNIX mail format.

In.toc, Out.toc, and Trash.toc
These files are “tables of contents” for your mailboxes.  They make it 
much faster for Eudora to access your mail.

Eudora Log, Old Log
Eudora keeps records of the mail it transfers.  Those records are kept in 
these files.  Eudora keeps each file less than about 100K.

System 7 Aliases
You may make aliases for mail boxes and .toc files, and put those aliases 
in your Eudora Folder.  Do not put aliases to other folders in your Eudora 
Folder.
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Right Wrong
Figure 28.1. The right way and the wrong way to use System 7 aliases in the  

Eudora Folder.
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Sharing a Macintosh with Other People
If you are sharing a Macintosh with other users, make a copy of a Eudora 
Folder for each user.  The copies can be named whatever you like, and put 
anywhere you like, including on floppies or network volumes.  To tell 
Eudora which folder to use, launch Eudora by double-clicking on the 
Eudora Settings file in that folder.

Figure 28.2. Sharing one Macintosh among multiple Eudora users.

29.  A Word About Memory

Sometimes, Eudora tells you it needs more memory.

Figure 29.1. A low memory warning.
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The best thing to do is click “Quit”, and give Eudora more memory.  You 
can do this by selecting the Eudora application, and choosing “Get Info” 
from the Finder’s File menu. Type the amount of memory you want 
Eudora to have in the “Current size” box, close the window, and then 
launch Eudora again.

Figure 29.2. Changing Eudora’s memory size.

You can see Eudora’s estimate of how much memory it needs at any given 
time by choosing “About Eudora...” from the Apple menu.  Eudora 
estimates the amount of memory it needs based on your open windows 
and the size of the In, Out, and Trash mailboxes (which are constantly in 
use).  The best way to reduce how much memory Eudora needs is to clean 
up these mailboxes regularly; use other mailboxes for long-term mail 
storage.

Note: There’s no harm in giving Eudora more memory than it 
asks for.  Eudora is giving you the “Minimum RDA” when 
it suggests memory size.

QUALCOMM Incorporated Eudora Reference Guide



Eudora Reference Guide QUALCOMM Incorporated

30.  Summary of Menu Commands 

File
Basic file and mail program functions.

New Text Document
Create a new text file.

Open...
Open the selected message summary, or open a text file, or open a Eudora 
Settings file.

Close
Close the current window.
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Save
Save changes to the contents of the topmost window.  This applies to 
composition windows, text windows, and the Nicknames window.

Save As...
Save the current message(s) to a plain text file.

Send Queued Messages
Send any messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.

Page Setup...
Set printing options.

Print...
Print the current messages, text window, or Ph window.

Print Selection...
Print the current selection from a message, text window, or Ph window.

Send to Back
Move topmost window behind all others.

Quit
Exit Eudora.

Edit
Text-editing and sorting tools.  

Undo
Reverses the last editing action taken on a piece of text.

Cut
Delete selected text and place it on clipboard.

Copy
Copy selected text and place it on clipboard.
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Paste
Place contents of clipboard at chosen insertion point in message.

Paste as Quotation
Place contents of clipboard at insertion point, with ‘>’ characters at the 
beginning of each line to denote quoted text.

Clear
Delete selected text.

Select All
Select entire contents of message or mailbox.

Show Insertion Point
Scroll selection or insertion point into view.
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Wrap Selection
Inserts returns into the current selection, in the same way as Eudora does 
when it sends mail.  With the option key, unwraps text the way “Save 
As...” does when Guess Paragraphs is turned on.

Finish Nickname
Complete the partial text of a nickname in the field of a message.

Insert Recipient
Insert the chosen nickname/address from the Quick Recipient list at the 
insertion point.

Find
Search for designated text or character string within message(s).

Sort sub menu
Sorts message summaries in a mailbox.  Hold down the option key to 
reverse the order of the sort.  

Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open mailbox where incoming messages are stored until deleted or 
transferred to another mailbox.

Out
Open mailbox where messages you compose are stored, and where queued 
messages are held until actually sent, and where copies of sent messages 
may be initially stored.

Trash
Open mailbox where deleted messages are stored. 

[Your Mailboxes]
Mailboxes you create will also appear in this menu.
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Message
This menu lets you create and delete messages.

New Message
Create a message from scratch.

Reply
Reply to the sender of the current message.

Forward
Forward the current message to someone else.

Redirect
Forward the current message to someone else, but make the return address 
be the person who originally sent the message.
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Send Again
Resend a message rejected by the mail system.  Be sure to fix whatever 
caused the problem before you queue the message.

New Message To
Send a message to someone on the Quick Recipient list.

Reply To
Reply to the current message, but send the reply to someone on the Quick 
Recipient list.

Forward To
Forward the current message to someone on the Quick Recipient list.

Redirect To
Redirect the current message to someone on the Quick Recipient list.

Queue For Delivery
Save the message and mark it as “queued,” or ready to be delivered.

Change Queueing...
Queue a message, unqueue a queued one, or set a message for timed send.

Attach Document
Send file(s) along with the current message.

Delete
Transfer the current message to the Trash mailbox; also used for 
destroying messages in the Trash mailbox.

Transfer
Choose a mailbox from this menu, and the current message(s) will be 
transferred into it.

Special
If it doesn’t fit anywhere else, it goes in here.
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Ph...
Use the “ph” or “finger” directory services.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Choose a recipient from this menu, and the recipient will be removed from 
the Quick Recipient list.

Empty Trash
Destroy all messages in the Trash mailbox.

Compact Mailboxes
Reclaim unused space in mailboxes.  

Mailboxes
Create, move, rename or remove mailboxes or mail folders.
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Configuration...
Change program settings, including accounts, host names, connection 
method, and visual attributes. Settings in this dialog require more choice 
than just on and off.

Switches...
Turn options on and off.

Communications...
Communications Toolbox settings.  Not needed when using MacTCP.

Signature
Create or change the text added to the end of all your messages.

Nicknames...
Create abbreviations for addresses.

Forget Password
Make Eudora ask for your password the next time it checks for mail.

Change Password
Change your password on the POP server computer.  This requires a 
special server.

Window
All Eudora window titles are listed in this menu; choose one to bring 
it to the front.  Composition window titles are italicized to help 
distinguish them from other windows.
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